Ohio Department of Health
Bureau of Vital Statistics

Electronic Death Registration System (EDRS)
Guide

For

Funeral Directors

May 2016
# Table of Contents

Section 1 ........................................................................................................................................... 3  
  Introduction .................................................................................................................................. 3  
  Funeral Directors and Coroner/Physicians/E-Physicians Online with EDRS ......................... 3  
Section 2 ........................................................................................................................................... 4  
  Getting Started with EDRS ........................................................................................................... 4  
  Navigating the Software .............................................................................................................. 10  
  Record Status & Explanations ....................................................................................................... 14  
  Data Entry Tips ............................................................................................................................ 17  
  Error Message Pop-up ................................................................................................................... 18  
  Pandemic Feature ......................................................................................................................... 18  
Section 3 ........................................................................................................................................... 19  
  Steps for Creating a “Physician-Paper” Death Certificate ........................................................ 20  
  Steps for Creating a “Coroner-Electronic” Death Certificate ..................................................... 25  
Section 4 ........................................................................................................................................... 33  
  Reading Notes on a Record ......................................................................................................... 29  
  Adding Notes to a Record .......................................................................................................... 32  
  Locating an Existing Record Using the Search Option ............................................................. 34  
  Creating an Affidavit ................................................................................................................... 36  
  Printing a Blank Supplemental ................................................................................................... 44  
  Creating a Certificate of Service ................................................................................................ 46  
  Handling A Trade Call .................................................................................................................. 48  
Section 5 ........................................................................................................................................... 49  
  Viewing Errors on a Record ....................................................................................................... 49  
  EDRS Reports ............................................................................................................................... 50  
Section 6 ........................................................................................................................................... 53  
  Funeral Home Extract .................................................................................................................. 53  
Section 7 ........................................................................................................................................... 64  
  Tips for printing from EDRS ....................................................................................................... 64
Section 1

Introduction
The Ohio Department of Health, Bureau of Vital Statistics is pleased to provide you with this easy step guide for usage of the Electronic Death Registration System (EDRS).

Funeral Directors and Coroner/Physicians/E-Physicians Online with EDRS

When a funeral user creates a death record, said user will assign the record to the coroner/physician/e-physician. Once the funeral user completes the assigned portion of the record for Personal Info Complete, the coroner/physician/e-physician will subsequently complete their assigned portion. If the death record has been assigned to a coroner, the coroner will receive the death record electronically, input the medical information into EDRS, and certify the death record within EDRS at which point the funeral director can then review and then certify the certificate, which will mark it as Registered, and make it available for issuance by the Local Health Department. This process is the same for Coroners who are also E-Physicians. Paper assigned Physicians do not have the capability to receive electronic death records within EDRS and thus the funeral user must either print a paper death certificate and deliver it to the physician for completion by hand or the funeral user can email or fax the physician a PDF created death certificate for signage. Once the physician completes the death record, they can either mail, fax, or email the completed and signed certificate back to the funeral home.

Please note that if the email or fax option is utilized by any of the above named entities, the death record must retain the format correspondent to EDRS printing and must not present differently in size and must not show other markings such as a fax number or an email indicator.
Section 2

Getting Started with EDRS

To get started you will need to open your browser and enter the URL: https://vital.odh.ohio.gov in the address box.
Enter your user id and password. Click Log In

Click the button as prompted to continue

Ohio Department of Health Office of Vital Statistics

Please reference the Support Site for ongoing updates (such as system upgrades, policy changes, and other vital announcements). The home page is continually updated with important announcements. Should you have any questions or concerns about the IPHIS-EDRS application, please contact our HelpDesk at (614) 466-2531, option 3. Staff are available Monday through Friday, 8:00 AM to 5:00 PM. The HelpDesk will be closed during state holidays.

Password changes will occur every 60 days, and require the use of strong password guidelines. These include a password length of no less than 7 characters, one uppercase character, and one special character (i.e. $ % & or number).

[Click Here To Continue]
If prompted to install applications, user can either click the green Install button and follow the prompts or, if Citrix has already been downloaded, the user can hit Skip To Log On.

Click on the application icon: IPHIS/EDRS

<table>
<thead>
<tr>
<th>Main</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hospital Reporting</td>
</tr>
</tbody>
</table>

IPHIS/EDRS

Hint: Unable to find the resource you need? Use Search to locate it for you.
Click on the Permit Use option

An online application is attempting to access information on a device attached to your computer.

- Block access
  Do not permit the application to use these devices.

- Permit use
  Permit the application to use these devices.

Do not ask me again for this site.

If user has more than one funeral home location, the ‘select location’ dropdown box will appear for user to choose applicable location role. Once chosen, click OK.

Select Location

Select the Location that you will be working from.

Use Down arrow key to select correct entry. Press Enter Key.

User No. 10058
Name barton.smock VS Clerk
Function Group VS-USER - ODH/VS - Clerk
GUI Group VS-STATE - State Clerk
Location CENTRAL LOCATION
Loc Code CENTRAL
County Code
Address
City

OK
This is the Main Menu action screen for IPHIS/EDRS.
**Note:** if at any point when logging in, the user receives a message stating:

![Error Message]

...the user will need to log-out of EDRS for 15 minutes and then re log-in to clear the error. This message indicates that either a current session is open or that a previous session ended abnormally but is still open. The 15 minute threshold is the parameter set for an automatic session end.
Navigating the Software

Each screen is composed of tabs, paragraphs, and fields.

- The tabs can be thought of as pages. These pages can be as long as needed but usually just take up one screen for ease of use.
- A tab usually contains information pertaining to one aspect of the Event.
- The user can go quickly from one tab to another by clicking on a tab heading with a mouse click or by pressing Alt-#, where # is the tab number (1, 2, 3, ...) to be accessed.

Each tab is composed of one or more paragraphs.

- These paragraphs have a title and are designed to pertain to some particular aspect of the Event.
- You can skip from paragraph to paragraph by pressing Ctrl-P.

Each paragraph is composed of one or more fields.

- Available field types are
  - drop-down
  - edit
  - check box
  - date edit
  - memo
  - signature

- The user moves from one field to another by
  - pressing the Tab key
  - automatic after entering data into the field with the appropriate type and number of characters
Review the main screen – menu bar & “drop down” options

The FILE menu item “drop down” options

The Search menu item “drop down” options
HOT KEYS
Presented below is a summary of various “hot key” combinations that can make certain data entry functions more efficient for those operators wanting to avoid use of the mouse and mouse menu navigation techniques. They include use of the Control key (Ctrl), the Alternate key (Alt) and the Shift key (Shift).

<table>
<thead>
<tr>
<th>Key Combination</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CTRL-C</td>
<td>COPY - This key copies the contents of the field containing the text cursor to the Windows clipboard. The field contents are not altered</td>
</tr>
<tr>
<td>CTRL-O</td>
<td>OVERRIDE - This key sets the edit override indicator for the field containing the text cursor.</td>
</tr>
<tr>
<td>CTRL-P</td>
<td>The data entry form is built from labeled boxes which are called PARAGRAPHS (in Windows terminology, they are called group boxes). Pressing Ctrl-P will move the text cursor from the present field to the first enterable field in the next paragraph.</td>
</tr>
<tr>
<td>CTRL-Q</td>
<td>QUERY - This key sets the query indicator for the field containing the text cursor.</td>
</tr>
<tr>
<td>CTRL-R</td>
<td>RESET QUERY/OVERRIDE - This key removes the query or override indicator. Note that a field can be either overridden or queried, but not both.</td>
</tr>
<tr>
<td>CTRL-S</td>
<td>This key SAVES the current Event. It is equivalent to the File</td>
</tr>
<tr>
<td>CTRL-V</td>
<td>PASTE - This key pastes the contents of the Windows clipboard into the field containing the text cursor. The new contents replace whatever was previously in the field.</td>
</tr>
<tr>
<td>CTRL-X</td>
<td>CUT - This key clears the present field and copies its contents to the Windows clipboard. From the clipboard it can be pasted into another data entry field, or into another Windows application which supports the clipboard.</td>
</tr>
<tr>
<td><strong>CTRL-Z</strong></td>
<td>This key CLEARS the contents of the field containing the text cursor.</td>
</tr>
<tr>
<td><strong>CTRL-DELETE</strong></td>
<td>If the text cursor is in a mask edit field (a field with slash or dash characters), the field will be cleared, or DELETED, when Ctrl-Delete is pressed.</td>
</tr>
<tr>
<td><strong>CTRL-TAB</strong></td>
<td>This key combination will select the next notebook page. When the last notebook page is displayed, this key combination will display the first page.</td>
</tr>
<tr>
<td><strong>SHIFT-CTRL-TAB</strong></td>
<td>This key combination will select the previous notebook page.</td>
</tr>
<tr>
<td><strong>ALT-A Through ALT-Z</strong></td>
<td>Certain menu items have underscores under a letter in the item name. Pressing Alt plus that letter is equivalent to selecting the menu item.</td>
</tr>
<tr>
<td><strong>ALT-1 Through ALT-9</strong></td>
<td>These keys select notebook pages, or tabs, 1-9, respectively.</td>
</tr>
<tr>
<td><strong>ALT-F4</strong></td>
<td>This key combination will close the current window. It is equivalent to clicking the close window [X].</td>
</tr>
<tr>
<td><strong>T (date field)</strong></td>
<td>Entering the letter “T” in a date field will insert “Today’s” date. The date can then be advanced by entering an “F”, for Forward or brought back in time by entering a “B” for Back.</td>
</tr>
<tr>
<td><strong>Left Mouse Click</strong></td>
<td>The left mouse button can be used to place the text cursor in a particular field by clicking when the mouse cursor is over the desired field. The left mouse can also select notebook pages by clicking on the tab for the desired page.</td>
</tr>
</tbody>
</table>
Right Mouse Click

A menu of options for a field may be displayed by clicking the right mouse button when the mouse cursor is positioned over the field.

Record Status & Explanations

Pending Status

A death event record is considered to be pending from the time the initial information is saved into the EDRS Database. The record will remain in pending status until the personal information is signed and medical information is certified for the death record and the owner changes the status to “Y” for “Complete.”

If the funeral director or coroner/physician assigned to the case reset the flag to “N” on the “Complete” acknowledged field to allow for changes in the personal information portion of the record, the record will be assigned the pending status.

Complete Status Defined

A death event record is considered complete only in the following scenarios:

1. On the electronic death certificate sent to coroner, the funeral director has completed the personal information and the coroner has completed the medical information and the certification box.

2. On a paper death certificate sent to the physician, the funeral director has selected the “Paper-Phy” type, completed the personal information and printed the death certificate.
Filed Status Defined.
A death certificate record is considered **filed** when the record has been reviewed and approved by the local registrar with date filed information entered into the EDRS record and a local file number assigned.

Once a record is **filed**, the funeral director/coroner/physician assigned to the death record cannot update the record unless rejected by a state clerk and re-assigned pending or complete status.

The local registrars assigned to the record and who are responsible for filing the death occurring in their jurisdiction shall **file** the death record.

Registered Status Defined
A death certificate for a Paper-Phy record is considered to be **registered** when the record in filed status is verified at Vital Statistics. A death certificate for an Electronic (coroner designated) record is considered to be **registered** when the local health department files the record. Once a record is **registered**, the funeral directors, coroner/physician and local registrar assigned to the death record cannot print or update the record.

Void Status Defined
There may be instances where a death record needs to be **voided**. For example, the information for a death is entered twice. The record cannot be deleted, because Ohio Department of Health/Vital Statistics will need to be able to account for the State File Number. In this instance, the person finding the duplicate entry will be required to report the entry to Vital Statistics. Only Vital Statistics staff with the proper authority will have the ability to change the status of a record to **void**.

Complete to Filed
After receiving the death certificate signed from the funeral director, the local registrar will enter additional information into EDRS. This will include:

- Date the registrar signed the death certificate, which will be applied by the system when the registrar electronically signs the death certificate
- Name of the registrar
- Name, PRDN and date for burial permit issuance if provisional death certificate was not requested.

After this additional information has been saved, the status of the death event record will change from complete to filed for a Paper-Phy record, and from complete to registered for an Electronic (coroner designated) record at which point a local file number is assigned to the record.
Complete to Pending

If the funeral director changes the personal information completion field from “Y” to “N” or the coroner/physician changes the certifications of medical information from “Y” to “N” the record status will be changed back to pending.

Filed to Registered

When a death certificate record has a status of filed, the record will available for the Vital Statistics staff. For the “Paper-Phy” records, the medical information which is not in EDRS will be updated by Vital Statistics.

If the Vital Statistics staff member verifies that all the information is correct and available in the EDRS system, the status of the record will change from filed to registered.

If the Vital Statistics staff member determines the record is not acceptable, the record status will be maintained as filed until registrar responds with corrected information.

Once the death certificate record is registered, an Affidavit for funeral home information can be completed or a Supplement for certifier information can be completed and registered at Vital Statistics.
Data Entry Tips

- County selection in the Place of Death paragraph will determine the registrar assignment on the record. This automatic assignment cannot be changed for the registrar filing the record, but can be changed for the sub-registrar approving the permit.
- Trade Call – Can be used to input the embalming home service provider on the record.
- A funeral director cannot input “Cause of Death” on a record in EDRS. This will be entered by Vital Statistics after receipt of the paper death certificate.
- The age of a deceased is calculated in the background. The system will notify you of an error via a pop-up error message if it doesn’t match.
- When entering the ‘Time of Death’ you can enter a range if the exact time is not known. For example, 12:23 time of death with a range of 11:32 to 13:09.
- The burial permit can be printed by the registrar or the funeral director, and should be determined on a ‘case by case’ basis.
- If a record is placed in Electronic (coroner designated) filing status, and is then determined to be a Paper-Phy record, the changing of the filing type will not update the record or assign an SFN- the record will need voided via calling the Vital Statistics HelpDesk.
- If a record is placed in Paper-Phy filing status, and is then determined to be an Electronic (coroner designated) record, the changing of the filing type can be updated by calling the Vital Statistics HelpDesk.
- In the case of a social security number being unknown, not obtainable, or not applicable, it must be entered as all 9s.
- In the case of a social security number status being returned as failed, as long as the funeral user has verified the info with the family, documentation, etc...the failed message does not impact the normal processing of the death record up to and including printing, saving and filing.
Error Message Pop-up
The pop-up error message box appears when the system does not accept your data entry. You can choose to “re-key the field”, “skip for now”, “override edit”, or “query field”.
- When you select “re-key the field” the system will immediately place the cursor in the field requiring the correction.
- When you select the “skip for now” the system will allow you to move past the error and correct it later.
  - The section on “Reviewing Errors” later in this document provides instructions on how to view the fields with errors that you have skipped during data entry.
- When you select the “override edit” option, the system will let you save the record and the registrar will review the override for correctness. Use this option when you are positive the data entry is correct.
- Selecting “query field” will flag/highlight the entry and keep the data as entered.

Pandemic Feature
The new system features a Pandemic capability. If this feature were to be needed, Vital Statistics will provide you with instructions and support for its use.
Section 3

As you are entering the personal information for the deceased, you will need to make several selections/decisions regarding the record.

- For Physician records, the Paper-Phys filing type must be selected. For Coroner records, the Electronic filing type must be selected.
- Selection of the certifier – Although all of the physicians are not actively using the system, his or her name must be selected from the drop down list in the certifier field. If a physician is not in the dropdown database, you must choose Other and type the certifier’s information in manually. For license info and verification, please refer to [https://license.ohio.gov/lookup/default.asp](https://license.ohio.gov/lookup/default.asp).
- Determine if the deceased is a Veteran. If they are a Veteran, you must input the information on the death record. The information does NOT print on the certificate.
Steps for Creating a “PAPER-PHYSICIAN” Death Certificate

Click File - New – Death

Begin entering the decedent information (First Name, Middle Name, Last Name, Date of Death, etc.)
Enter information for Decedent, Veteran (if necessary), Relative/Informant, Disposition, Trade Call (if necessary), Certifier, Completed tabs

Note: If the deceased is a Veteran you will need to enter a “Y” in the Armed Forces box. This will trigger the Veteran tab to allow data entry. The “N” indicates the tab is not needed on the record, and the fields remain grayed out.

Enter “Y” on “N” in Ever in Armed Forces?

If you enter “Y” the Veteran tab opens for data entry. If you enter “N” the Veteran tab will remain grayed out.

Enter the Veteran information for the deceased, if necessary.
Select the Certifier Name from the “drop down” list

Note: On both Physician (paper) and Coroner or E-Physician (electronic) records, the Paper or Electronic designation will automatically update based on the type of Certifier chosen.

If the Physician name is not in the dropdown, funeral user will need to choose Other and type the information as required on the Certifier tab. License info can be searched and verified at https://license.ohio.gov/lookup/default.asp.

On the Registrar tab, request either a burial or cremation permit. If the Disposition is Removal From State, the transit permit will be requested via the Burial permit checkbox.
On the Completed tab, enter “Y” Personal Info Complete (all dates will autopopulate with Save action). On the Completed tab, enter another “Y” in the certification statement (only a funeral director can enter this field).

<table>
<thead>
<tr>
<th>Relative/Informant</th>
<th>Disposition</th>
<th>Trade Call</th>
<th>Certifier</th>
<th>Cause of Death</th>
<th>Registrar</th>
<th>Completed</th>
<th>Read</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Funeral Home</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Personal Info Complete ([Y/N/R]?):</td>
<td>Complete Date</td>
<td>Completed by</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>N</td>
<td>//</td>
<td>____________</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

By certifying below, I attest that the facts stated herein are true and accurate to the best of my knowledge.

<table>
<thead>
<tr>
<th>Date Signed</th>
<th>Funeral Director Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>//</td>
<td>________________</td>
</tr>
</tbody>
</table>

Click File – Save

SSN Verification

After you save the record, the system will notify you of the SSN checking process. Click “OK” to exit pop up window.

To check the status of the online SSN verification you will need to:
- close the record (after it has been saved)
- reopen the record (using the SEARCH utility or the work queue to locate the record)
- on the Decedent tab, check the Return Status field for SSN Verification
The maximum number of attempts for verification of a SSN is 5. The SSN field will be locked once the verification is sent by SSA.

Note: The combination of completing and saving, and then certifying and saving, will change the status of the record from Pending to Complete. The death certificate can now be printed.

Note: The status of the SSN record (Passed, Failed, etc...) does not impact the normal death record completion process. If an SSN is in a failing status, but has been verified as a match with what the family provided, the death record process should continue up to and including being filed at the local health department.

Note: Once the social security number has passed, it will lock the fields of the decedent’s Name, Date of Birth, and Gender.

Select Requests – Print: Death Certificate-Paper
Steps for Creating an “Coroner-Electronic” or “E-Physician” Death Certificate

**Click File - New - Death**

Enter Deceased Information (First Name, Middle Name, Last Name, Date of Death, etc.)
Enter "Y" on "N" in Ever in Armed Forces?

If you enter “Y” the Veteran tab opens for data entry. If you enter “N” the Veteran tab will remain grayed out.

Enter the Veteran information for the deceased, if necessary.
Select the Certifier Type and Name from the “drop down” list

Note: On both Physician (paper) and Coroner or E-Physician (electronic) records, the Paper or Electronic designation will automatically update based on the type of Certifier chosen.

On the Registrar tab, request either a burial or cremation permit. If the Disposition is Removal From State, the transit permit will be requested via the Burial permit checkbox.
Enter “Y” for Personal Info Complete.

Note: it is a good practice for the funeral user to avoid entering the second “Y” for certification until the coroner or e-physician has certified the record, as once both the funeral director and coroner/e-physician certify the record, it is placed in the final Registered status and cannot be amended without an affidavit or supplement.

At this point, the assigned coroner will be able to view and edit the record on the cause of death tab. Once the coroner completes and certifies the record, the funeral home will be able to review it and then certify it, which will put the record in Registered status, and will then be available for issuance at the Local Health Department.

SSN Verification

After you save the record, the system will notify you of the SSN checking process. Click “OK” to exit pop up window.

To check the status of the online SSN verification you will need to:

- close the record (after it has been saved)
- reopen the record (using the SEARCH utility or the work queue to locate the record)
- on the Decedent tab, check the Return Status field for SSN Verification
The maximum number of attempts for verification of a SSN is 5. The SSN field will be locked once the verification is sent by SSA.

Section 4

Reading Notes on a Record

Click Actions – Show Notes
The Note Present indicator is displayed on the bottom of the screen when a note is attached to the record.

Tip: The record must be OPEN to read the attached notes.
When multiple notes are on a record, you need to highlight the note you want to read and it will display in the box on the bottom half of the screen. As the number of notes on a record grows, you may need to use the scroll bar on the side of the window to get to the note you need to read.
Adding Notes to a Record

Click Actions – Show Notes

While the record is OPEN in the background, you can add the note.
IMPORTANT!! YOU MUST SAVE THE RECORD TO SAVE THE NOTE AND COMPLETE THE PROCESS!

Click – New and type your note

Click – Save to save the note

Click – Close to exit the window

After adding your note, saving it and closing the screen, you must SAVE YOUR RECORD too!
Locating an Existing Record Using the Search Option

Click Search – Death

Enter First Name, Middle Name, Last Name and click Search
Highlight the record – click Display.

System will display the record.
Creating an Affidavit

Note: The record must be open prior to starting this process. To find a record, go to Locating an Existing Record Using the Search Option earlier in this section.

From the DISPLAYED death record, click File – New – Affidavit

Enter the general information on Applicant tab

(this information is usually the funeral director’s name and location)
Note: if the decedent’s information is not showing at the bottom of the applicant tab, the affidavit has not been correctly accessed and will not link to the death record. User must access File>New>Affidavit from the displayed death record.

**Enter information “to be corrected” on Corrections tab**

![EDRS screenshot](image)

Note: if the item the funeral user is correcting is either not in the dropdown OR displays correctly in EDRS but incorrectly on the manual death certificate, the Item to be Corrected can be left blank, which will leave the Original Entry blank, and both entries can be manually written on the affidavit once it is printed.

The Affidavit of Personal Knowledge section should auto-fill from the Applicant tab. The only field to be filled out here would be the County of field.
Enter the Central Office information for the Affidavit

Enter “Y” into Affidavit Info Completed and Signed

This is the only field to be entered here. If the Record Status is changed manually in any way, it will impact the printing of the affidavit and may lead to it needing deactivated.

Date Affirmed/Subscribed
Leave this date field blank for the registrar to input after receipt of the notarized Affidavit.
Click File – Save

The signed date and the Record Status will automatically update.

Click Requests – Print: Affidavit of Death
Note: if user receives the below message, the affidavit was not accessed correctly or was changed manually in the Central Office/Record Status field and will need restarted.
Printing a Blank Supplemental

The physicians not online with EDRS will be required to submit medical supplements related to the death record. In order to track the medical supplemental form, it must have the case file number, also referred to as the ODH number, on it. To accommodate this requirement, the funeral directors and clerks, registrars and clerks and sub-registrars can print a blank medical supplement with the key demographic information. The original record will need to be opened and have the filed or registered status in order to print this blank supplemental form.

The record must be in an overall filed or registered status, personal information in complete status and the medical information in paper status.

Display the death record and access Requests-Print:Supplemental Blank
To print the blank supplemental click the printer icon in the upper left corner.
Creating a Certificate of Service

Click – File – New – Certificate of Service

Enter information for the deceased.
Enter “Y” for Complete and Date Completed

Click File - Save

Click Requests – Print: Death Certificate of Service
Handling a Trade Call

- The funeral home information to be printed on the certificate will be entered on the DISPOSITION tab. (If the funeral home is not in the drop down list, select the OTHER option and use the text box to enter the information.)
- The information for the funeral home working on the record, but not printed on the certificate, will be entered on the TRADE CALL tab.

NOTE: To remove the funeral director license number and allow the funeral director to sign and write their license number on the death certificate, select a funeral director from the drop down, delete it from the field (Ctrl-Z) and click Override Edit from the pop-up box.
Section 5

Viewing Errors on a Record

The system allows you to address errors individually during the data entry process or through the Field Edit Results Display Screen.

With the record OPEN, Click Actions – Review Errors/Queries

Note:  Soft Edits: is information entered into a field outside normal acceptable range, but have been verified to be correct and have been overridden in the system to complete the record.

Hard Edits: is information entered into a field that is not acceptable and must be corrected or the system will not allow completion.

Tips:

- Double click on the field name listed as having an error to return to make correction.
- To exit the screen: click the X in upper right corner.

Note:  Soft Edits: is information entered into a field outside normal acceptable range, but have been verified to be correct and have been overridden in the system to complete the record. Hard Edits: is information entered into a field that is not acceptable and must be corrected or the system will not allow completion.
EDRS Reports
The system has a Provisional Filed and SSN Not Validated report for you to view or print. To access these reports you will use the Batch menu option.

Select menu options Batch - Reports

Click + next to DEATH folder; Click the report you want to view
After clicking the report you want to view, click the Preview button.

The system will display the report on screen in a ‘print preview’ window.
Section 6

Funeral Home Extract

Extract Administrator – Generating the Extract File

***Please read this section entirely before proceeding with an Extract.***

As a funeral director extract administrator, you can now extract data from EDRS system to import to other systems you may be supporting. This process allows you to extract a file of death certificate information and then import the file into your application of choice.

***WARNING! Follow these steps exactly and you will not have to modify the extract settings.***

Follow these guidelines to extract death record information from EDRS.

1) Create a folder on your workstation hard drive.

   Note: This spelling must be an exact match or the EDRS extract function will error when you try to run it.

   - Open up Windows Explorer. *Note: You can also double click on “My Computer” and then double click on the (C:) drive to create the new folder.*
   - Highlight the Local Disk (C:).
   - Then select “New” and then “Folder” from the explorer menu.
   - Name the folder
   - **Important**: You must remember this name EXACTLY.
2) Then login into the EDRS system as a funeral home extract administrator.  
   ➢ No one else can run this process.

![Select Location window]

3) Select “Batch” and then “Exports” from the application menu bar.

![Batch and Exports selection]

*Note:* The system will prompt you to select the location (profile) again for the extract administrator.
4) Once you select the appropriate profile, click “OK”
Note: All users will receive this pop-up message, simply click “OK” to close.

Note: If you have saved previous extracts which display in this listing, you may highlight and select them. However, if a record has been extracted previously and the “perform updates” box was checked, it cannot be extracted again. The “perform updates” box is on the next screen.
This screen has 4 areas of input to be performed in the following order:

#1 Input the folder names you created on your hard drive. The names MUST MATCH exactly. V: = C: for users in EDRS, so you MUST use the V: to represent C: in the field.

**Note:** If you do not rename your files, the system will AUTOMATICALLY overwrite your files.

#2 For ease of use, leave the Date of Death BEG,END field the ENTIRE YEAR. For example: 01/01/2007,12/31/2007.

**Note:** Once the records have been extracted, they cannot be pulled again, therefore the dates you have in this field do not make a difference with records getting pulled a second time.

#3 Perform Updates – sets a flag in the system, stating the records have been pulled.

#4 Start Extract - will initiate the pulling of records, which have NOT been previously pulled.
If you receive the following message after starting the extract, it is because your names do not match for the folders. Click OK and re-key the folder names on the extract screen under step #1.

![Extractprj](image)

Click No in the following window to not save the parameter. Even though it allows you to save the parameters, you cannot extract records more than once.

![Confirm](image)

**Note:** The way the extracts are pre-configured, it will automatically select records that have not been previously exported.

**Tip:** You can run this extract without checking the “Perform Updates” box for a test run of the extract, but it must be checked to mark the records as extracted so the next time you run the extract it will ignore previously downloaded data.

- When this is “Not” checked, the extract will pull data without updating which records were extracted.
- When this is checked, the extract will pull data and update the record so that data is not pulled in subsequent extracts.
  - This flagging is to PROTECT you from pulling the same record more than once.

You will ALWAYS get the NEW and OLD records which have not been FLAGGED as extracted.

A progress bar will appear stating “Counting records.”

- You will see a progress bar that will show you;
  - Records Processed.
  - Records Written.
  - Total Number of records.
  - Any Errors.
Once extract has completed progress bar will state “Processing Completed”.

Your extract is now completed. Click on the “Completed” button on the extract status bar to close this dialog.

**Reviewing Your Extract File**

This is a good time to review the output files and determine if there are any issues. Go to the folder on your hard drive and locate the extract file names you created. Double click on the file and review the information. The Error Log file should be blank. The main extract file should contain your data.

**Note:** The Ohio Department of Health, Office of Vital Statistics HIGHLY RECOMMENDS that you rename this file, so that the next time you extract information the file isn’t overwritten with new data.

a. To rename the file, open the folder where the extract is located.

b. Right click on the file and select rename from the menu.
The recommended name for the file is “DEATH” followed by the date the extract was run and the file extension of “txt”.

Example: DEATH03172006.txt, indicates that this file was created on March 17, 2006. Because this was the date used to extract the information, it will match the data that the EDRS system updated the records that were pulled from the system.

***At this time the EDRS application does not support the use of the “Schedule Extract” feature.***

For the funeral homes requiring extraction of death records filed by their institution, the following file layout has been created.

- Records extracted are assigned to the funeral home of the current user logged into EDRS.
- The user has the option to select non extracted or all records based on range of dates i.e. begin date and end date.
The funeral home extract administrator and the ODH/VS System/Extract Administrator can extract this information.

<table>
<thead>
<tr>
<th>Serial Number</th>
<th>Field Name</th>
<th>Field length</th>
<th>Field Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Decedent First Name</td>
<td>50</td>
<td>Varchar</td>
</tr>
<tr>
<td>2</td>
<td>Decedent middle name</td>
<td>80</td>
<td>Varchar</td>
</tr>
<tr>
<td>3</td>
<td>Decedent Last name</td>
<td>50</td>
<td>Varchar</td>
</tr>
<tr>
<td>4</td>
<td>Decedent name suffix</td>
<td>10</td>
<td>Varchar</td>
</tr>
<tr>
<td>5</td>
<td>Alias indicator 1</td>
<td>1</td>
<td>Varchar</td>
</tr>
<tr>
<td>6</td>
<td>Alias Name 1</td>
<td>250</td>
<td>Varchar</td>
</tr>
<tr>
<td>7</td>
<td>Alias indicator 2</td>
<td>1</td>
<td>Varchar</td>
</tr>
<tr>
<td>8</td>
<td>Alias Name 2</td>
<td>250</td>
<td>Varchar</td>
</tr>
<tr>
<td>9</td>
<td>Alias indicator 3</td>
<td>1</td>
<td>Varchar</td>
</tr>
<tr>
<td>10</td>
<td>Alias Name 3</td>
<td>250</td>
<td>Varchar</td>
</tr>
<tr>
<td>11</td>
<td>Sex</td>
<td>1</td>
<td>Varchar</td>
</tr>
<tr>
<td>12</td>
<td>SSN</td>
<td>9</td>
<td>Varchar</td>
</tr>
<tr>
<td>13</td>
<td>Date of Death</td>
<td>10</td>
<td>Date</td>
</tr>
<tr>
<td>14</td>
<td>Date of Death Text</td>
<td>15</td>
<td>Varchar</td>
</tr>
<tr>
<td>15</td>
<td>Date of birth</td>
<td>10</td>
<td>Date</td>
</tr>
<tr>
<td>16</td>
<td>Age</td>
<td>3</td>
<td>Varchar</td>
</tr>
<tr>
<td>17</td>
<td>Age indicator</td>
<td>28</td>
<td>Varchar</td>
</tr>
<tr>
<td>18</td>
<td>Place of death</td>
<td>40</td>
<td>Varchar</td>
</tr>
<tr>
<td>19</td>
<td>Facility name</td>
<td>50</td>
<td>Varchar</td>
</tr>
<tr>
<td>20</td>
<td>Facility City</td>
<td>40</td>
<td>Varchar</td>
</tr>
<tr>
<td>21</td>
<td>Facility county</td>
<td>40</td>
<td>Varchar</td>
</tr>
<tr>
<td>22</td>
<td>Facility state</td>
<td>25</td>
<td>Varchar</td>
</tr>
<tr>
<td>23</td>
<td>Facility zip code</td>
<td>15</td>
<td>Varchar</td>
</tr>
<tr>
<td>24</td>
<td>Armed service</td>
<td>1</td>
<td>Varchar</td>
</tr>
<tr>
<td>25</td>
<td>Disposition name</td>
<td>40</td>
<td>Varchar</td>
</tr>
<tr>
<td>26</td>
<td>Cemetery name</td>
<td>60</td>
<td>Varchar</td>
</tr>
<tr>
<td>27</td>
<td>Cemetery city</td>
<td>45</td>
<td>Varchar</td>
</tr>
<tr>
<td>28</td>
<td>Cemetery state</td>
<td>45</td>
<td>Varchar</td>
</tr>
<tr>
<td>29</td>
<td>Decedent resident address</td>
<td>60</td>
<td>Varchar</td>
</tr>
<tr>
<td>30</td>
<td>Decedent residence number</td>
<td>10</td>
<td>Varchar</td>
</tr>
<tr>
<td>31</td>
<td>In city limits</td>
<td>1</td>
<td>Varchar</td>
</tr>
<tr>
<td></td>
<td>Description</td>
<td>Length</td>
<td>Type</td>
</tr>
<tr>
<td>---</td>
<td>-----------------------------------</td>
<td>--------</td>
<td>-------</td>
</tr>
<tr>
<td>32</td>
<td>Residence zip code</td>
<td>15</td>
<td>Varchar</td>
</tr>
<tr>
<td>33</td>
<td>Residence city</td>
<td>40</td>
<td>Varchar</td>
</tr>
<tr>
<td>34</td>
<td>Residence county</td>
<td>40</td>
<td>Varchar</td>
</tr>
<tr>
<td>35</td>
<td>Residence state</td>
<td>25</td>
<td>Varchar</td>
</tr>
<tr>
<td>31</td>
<td>Dec resident country</td>
<td>40</td>
<td>Varchar</td>
</tr>
<tr>
<td>32</td>
<td>Birth state</td>
<td>25</td>
<td>Varchar</td>
</tr>
<tr>
<td>33</td>
<td>Birth country</td>
<td>40</td>
<td>Varchar</td>
</tr>
<tr>
<td>34</td>
<td>Marital status</td>
<td>50</td>
<td>Varchar</td>
</tr>
<tr>
<td>35</td>
<td>Spouse first Name</td>
<td>45</td>
<td>Varchar</td>
</tr>
<tr>
<td>36</td>
<td>Spouse middle Name</td>
<td>80</td>
<td>Varchar</td>
</tr>
<tr>
<td>37</td>
<td>Spouse last Name</td>
<td>45</td>
<td>Varchar</td>
</tr>
<tr>
<td>38</td>
<td>Spouse suffix</td>
<td>10</td>
<td>Varchar</td>
</tr>
<tr>
<td>39</td>
<td>Father first Name</td>
<td>45</td>
<td>Varchar</td>
</tr>
<tr>
<td>40</td>
<td>Father middle Name</td>
<td>80</td>
<td>Varchar</td>
</tr>
<tr>
<td>41</td>
<td>Father last Name</td>
<td>45</td>
<td>Varchar</td>
</tr>
<tr>
<td>42</td>
<td>Father suffix</td>
<td>10</td>
<td>Varchar</td>
</tr>
<tr>
<td>43</td>
<td>Mother first Name</td>
<td>45</td>
<td>Varchar</td>
</tr>
<tr>
<td>44</td>
<td>Mother middle Name</td>
<td>80</td>
<td>Varchar</td>
</tr>
<tr>
<td>45</td>
<td>Mother last Name</td>
<td>45</td>
<td>Varchar</td>
</tr>
<tr>
<td>46</td>
<td>Mother suffix</td>
<td>10</td>
<td>Varchar</td>
</tr>
<tr>
<td>47</td>
<td>Informant first Name</td>
<td>45</td>
<td>Varchar</td>
</tr>
<tr>
<td>48</td>
<td>Informant middle Name</td>
<td>80</td>
<td>Varchar</td>
</tr>
<tr>
<td>49</td>
<td>Informant last Name</td>
<td>45</td>
<td>Varchar</td>
</tr>
<tr>
<td>50</td>
<td>Informant Suffix</td>
<td>10</td>
<td>Varchar</td>
</tr>
<tr>
<td>51</td>
<td>Informant related to decedent</td>
<td>40</td>
<td>Varchar</td>
</tr>
<tr>
<td>52</td>
<td>Informant mailing address</td>
<td>60</td>
<td>Varchar</td>
</tr>
<tr>
<td>53</td>
<td>Informant city</td>
<td>40</td>
<td>Varchar</td>
</tr>
<tr>
<td>54</td>
<td>Informant state</td>
<td>40</td>
<td>Varchar</td>
</tr>
<tr>
<td>55</td>
<td>Informant zip code</td>
<td>15</td>
<td>Varchar</td>
</tr>
<tr>
<td>56</td>
<td>Decedent education</td>
<td>50</td>
<td>Varchar</td>
</tr>
<tr>
<td>57</td>
<td>Hispanic origin</td>
<td>1</td>
<td>Varchar</td>
</tr>
<tr>
<td>58</td>
<td>Mexican</td>
<td>1</td>
<td>Varchar</td>
</tr>
<tr>
<td>59</td>
<td>Puerto Rican</td>
<td>1</td>
<td>Varchar</td>
</tr>
<tr>
<td>60</td>
<td>Cuban</td>
<td>1</td>
<td>Varchar</td>
</tr>
<tr>
<td>61</td>
<td>Other</td>
<td>1</td>
<td>Varchar</td>
</tr>
<tr>
<td></td>
<td>Description</td>
<td>Length</td>
<td>Type</td>
</tr>
<tr>
<td>---</td>
<td>--------------------------------------------------</td>
<td>--------</td>
<td>--------</td>
</tr>
<tr>
<td>62</td>
<td>Other description</td>
<td>20</td>
<td>Varchar</td>
</tr>
<tr>
<td>63</td>
<td>Race - White</td>
<td>1</td>
<td>Varchar</td>
</tr>
<tr>
<td>64</td>
<td>Race - Black</td>
<td>1</td>
<td>Varchar</td>
</tr>
<tr>
<td>65</td>
<td>Race - American Indian or Alaskan Native</td>
<td>1</td>
<td>Varchar</td>
</tr>
<tr>
<td>66</td>
<td>Race - Native Description 1</td>
<td>30</td>
<td>Varchar</td>
</tr>
<tr>
<td>67</td>
<td>Race - Native Description 2</td>
<td>30</td>
<td>Varchar</td>
</tr>
<tr>
<td>68</td>
<td>Race - Asian Indian</td>
<td>1</td>
<td>Varchar</td>
</tr>
<tr>
<td>69</td>
<td>Race - Chinese</td>
<td>1</td>
<td>Varchar</td>
</tr>
<tr>
<td>70</td>
<td>Race - Filipino</td>
<td>1</td>
<td>Varchar</td>
</tr>
<tr>
<td>71</td>
<td>Race - Japanese</td>
<td>1</td>
<td>Varchar</td>
</tr>
<tr>
<td>72</td>
<td>Race - Korean</td>
<td>1</td>
<td>Varchar</td>
</tr>
<tr>
<td>73</td>
<td>Race - Vietnamese</td>
<td>1</td>
<td>Varchar</td>
</tr>
<tr>
<td>74</td>
<td>Race - Other Asian</td>
<td>1</td>
<td>Varchar</td>
</tr>
<tr>
<td>75</td>
<td>Race - Other Asian Description 1</td>
<td>30</td>
<td>Varchar</td>
</tr>
<tr>
<td>76</td>
<td>Race - Other Asian Description 2</td>
<td>30</td>
<td>Varchar</td>
</tr>
<tr>
<td>77</td>
<td>Race - Native Hawaiian</td>
<td>1</td>
<td>Varchar</td>
</tr>
<tr>
<td>78</td>
<td>Race - Guamanian or Chamorro</td>
<td>1</td>
<td>Varchar</td>
</tr>
<tr>
<td>79</td>
<td>Race - Samoan</td>
<td>1</td>
<td>Varchar</td>
</tr>
<tr>
<td>80</td>
<td>Race - Other Pacific Islander</td>
<td>1</td>
<td>Varchar</td>
</tr>
<tr>
<td>81</td>
<td>Race - Other Pacific Islander Description 1</td>
<td>30</td>
<td>Varchar</td>
</tr>
<tr>
<td>82</td>
<td>Race - Other Pacific Islander Description 2</td>
<td>30</td>
<td>Varchar</td>
</tr>
<tr>
<td>83</td>
<td>Race - Other</td>
<td>1</td>
<td>Varchar</td>
</tr>
<tr>
<td>84</td>
<td>Race - Other Description 1</td>
<td>30</td>
<td>Varchar</td>
</tr>
<tr>
<td>85</td>
<td>Race - Other Description 2</td>
<td>30</td>
<td>Varchar</td>
</tr>
<tr>
<td>86</td>
<td>Race - Unknown</td>
<td>1</td>
<td>Varchar</td>
</tr>
<tr>
<td>87</td>
<td>Race - Not Obtainable</td>
<td>1</td>
<td>Varchar</td>
</tr>
<tr>
<td>88</td>
<td>Race - Refused</td>
<td>1</td>
<td>Varchar</td>
</tr>
<tr>
<td>89</td>
<td>Occupation</td>
<td>60</td>
<td>Varchar</td>
</tr>
<tr>
<td>90</td>
<td>Industry</td>
<td>60</td>
<td>Varchar</td>
</tr>
<tr>
<td>91</td>
<td>Physician assigned</td>
<td>1</td>
<td>Varchar</td>
</tr>
<tr>
<td>92</td>
<td>Physician Name</td>
<td>75</td>
<td>Varchar</td>
</tr>
<tr>
<td>93</td>
<td>Coroner assigned</td>
<td>1</td>
<td>Varchar</td>
</tr>
<tr>
<td>94</td>
<td>Coroner Name</td>
<td>75</td>
<td>Varchar</td>
</tr>
<tr>
<td>95</td>
<td>Funeral Home Identifier</td>
<td>10</td>
<td>Varchar</td>
</tr>
<tr>
<td>96</td>
<td>Funeral director name</td>
<td>75</td>
<td>Varchar</td>
</tr>
</tbody>
</table>
Section 7

Tips for Printing from EDRS

If, when trying to print from EDRS, the document sent to the printer does not print, it’s possible the user’s EDRS settings are not selected for the printer in question. To choose the correct printer, go first to File>Print Setup:

Make sure the correct printer is showing in the printer name field. If not, select the correct printer from the dropdown box and close.
After verifying the File>Print Setup is correct, go to Tools and then Preferences:

Under Tools>Preferences, make sure that, for each document listed, the correct printer name is showing in the Printer field. If not, utilize the dropdown to choose the correct printer. Once finished, hit Save.
In the event the above options do not solve the printing issue, it’s possible the funeral user may need to change the Printer Property settings from the Start Menu of their terminal. To do this, access the Control Panel>Devices and Printers:
Right click on the default printer and select Printer Properties.

Access the advanced tab on the Printer Properties, and make sure the checkbox for Enable Advanced Printing Features is not checked. If it is, clear the checkbox and hit OK.